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Executive summary

Microsoft Corporation (Microsoft) commissioned Principled KEY FINDINGS
Technologies (PT) to develop and run a set of tests that e Windows Vista SP1 was noticeably more
compare the responsiveness of Windows Vista and responsive than Windows Vista on most of
Windows Vista SP1 using Windows Server 2003 and the file operations in this test when we
Windows Server 2008 on common business file tested with Windows Server 2008.
operations. We measured how responsive each operating
system (OS) was when performing a set of common ® Windows Vista SP1 was also noticeably
business file copy operations. We ran these tests with a more responsive than Windows Vista on
pair of servers running Windows Server 2003 and again most of the file operations in this test when
with the same servers running Windows Server 2008. we tested with Windows Server 2003.

) ) ) ® \Windows Server 2008 was faster on most of
The goal of the tests is to provide buyers with a sense of the file operations in this test than Windows
the differences in response time they would experience Server 2003.
when performing the same file operations on each

OS/server pair.

Test operations included copying files in several ways: between folders on a local drive, from a local drive to and
from a server accessed over a local area network (LAN) connection; and from a local drive to and from a server
accessed over a wide area network (WAN) connection that we simulated in our lab.

We ran the tests on four client systems1:

Dell XPS 600 (desktop)

Dell XPS M170 (notebook)
Hewlett-Packard d4100e (desktop)
Toshiba Tecra M4 (tablet)

We tested a total of four client-server OS platform combinations: each version of the client OS with each version
of the server OS. We ran all the tests on the following two client operating systems:

e Windows Vista Ultimate Version 6.0, build 6000 (Vista), the one that Microsoft released to manufacturing
e Windows Vista Ultimate version 6.0, build 6001, Service Pack 1, build 17128 (Vista SP1)

We ran all the tests using the following two server operating systems:

e Windows Server 2003 R2 (Server 2003)
e Windows Server 2008 RTM Escrow build (Build 6001.17128.080101-1935) (Server 2008)

We conducted each test using a test bed that included a client system with one of the above two client operating
systems and two servers, one connected via a 100Mb/s Ethernet LAN and the other via a simulated WAN. We
simulated a 100Mb/s WAN environment using Shunra Desktop VE to add 100ms round trip latency to the
100Mb/s network. The Test methodology section provides details on the network setup.

' The original testing included a Hewlett-Packard a1320y desktop PC. We omitted that system from the charts
and analysis in this report because it produced unacceptably high variability in its test results. Appendix D
provides configuration information and detailed test results for this system.



Microsoft provided the test systems and test settings. PT set up the systems; specified and developed the tests
and test procedures; set up the test environment including the test servers; and executed all the tests.

In this report, we examine the performance characteristics of the two Windows client and two Windows server OS
versions, not the differences among client systems. So, though all four client systems were shipping units whose
configurations we detail in Appendix A, we aggregate their results in the OS comparison charts, and in the bulk of
the report we refer to them as System A, System B, System C, and System D.

The 25 test operations come from a realistic business scenario that we created and scripted. The scenario covers
part of the day of Bob, the head of Sales and Marketing at Acme Ventures, a company that makes network
hardware and provides network services, including installation and testing. Acme Ventures has recently acquired
a small company across the country, WileyBeep, which, like Acme, makes network hardware. WileyBeep
specializes in servers. Bob is preparing for a training session at WileyBeep headquarters next month. He has set
aside some time to assemble materials that he needs for this session and wants to share with his colleagues at
WileyBeep. As he works, he copies files to and from several locations:

o the WileyBeep server via the WAN
e his local drive
e the Acme Ventures server via the LAN

The scenario includes file copy tasks using files and folders of different types and sizes. The scenario comprises
five typical business projects focusing on file copy operations. Four of the projects include copy operations to or
from the WAN or LAN servers. Each project involves a different source and destination:

Project 1: Bob copies files from the LAN server to his local drive
Project 2: Bob copies files from his local drive to the WAN server
Project 3: Bob copies files from the WAN server to his local drive
Project 4: Bob copies files between two folders on his local drive
Project 5: Bob copies files from his local drive to the LAN server

This report discusses the results of those tests and provides the following response time comparisons:

o Vista SP1 vs. Vista when connected to servers running Windows Server 2008

e Vista SP1 vs. Vista when connected to servers running Windows Server 2003

e Windows Server 2008 vs. Windows Server 2003 when copying files to and from a client system running
Vista SP1
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Vista SP1 vs. Vista when connected to servers running Windows Server 2008

Figure 1 compares the performance of Vista SP1 and Vista on 25 common business file operations with server
operations using Windows 2008 Servers.

Vista SP1 was noticeably more responsive than Vista on most of the file operations in this test when we tested
with Windows Server 2008. Vista SP1 provided better performance on 18 of the 25 file operations in this test,
leading by over 1 minute on two of the tasks and by a total of over 7.2 minutes on those 18 tasks. Vista SP1
showed the strongest leads in Projects 2 and 3, which copy files between the local drive and the WAN server.
Vista led on seven tasks, but only by at most 12.8 seconds on an individual task and by a total of 18.5 seconds on
all seven tasks.

Each bar in Figure 1 represents the average of the differences in response time on the four test systems between
Vista SP1 and Vista on one operation. The bars appear in the order in which the operations appear in the
scenarios. We describe each of those operations in the Scenario descriptions section. Bars above the 0.00
midline indicate tests in which Vista SP1 was faster. The yellow band contains all differences of less than 30
seconds.

Space constraints prevent us from labeling the individual operations in the figures in this section. We have labeled
them all in the Test results section and in the Detailed test results appendix.
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Figure 1: Average response time improvements of Vista SP1 over Vista on a variety of file operations on four systems when
connected to servers running Windows Server 2008. Numbers greater than zero indicate Vista SP1 was more responsive.
Differences of more than 30 seconds are outside the yellow band. We describe each of those operations in the Scenario
descriptions section.

Figure 2 displays the response time difference shown in Figure 1 as a percentage of the average Windows Vista
response time for each task. For example, if Windows Vista finished a task in a three-quarters of a second and
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Windows Vista SP1 finished it in a half second, the graph would show a 33 percent difference (the quarter-second
time difference divided by Vista’s three-quarter second response time). A positive result shows Vista SP1 is faster
by that percentage; a negative result shows Vista is faster by that percentage. The bars appear in the order in
which the operations appear in the scenarios, which we describe below. Bars above the 0.00 midline indicate
tests in which Windows Vista SP1 was faster. Windows Vista SP1 was more than 10 percent faster than Windows
Vista on 17 of the tasks in this project and more than 50 percent faster on six of the tasks. Windows Vista SP1
logged its largest win on the Copy WBPix WAN-to-local task, where it beat the Windows Vista time by 63 percent.
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Figure 2: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations on four systems
when connected to servers running Windows Server 2008. Numbers greater than zero indicate Vista SP1 was more
responsive. We describe each of those operations in the Scenario descriptions section.
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Vista SP1 vs. Vista when connected to servers running Windows Server 2003

Figure 3 displays the average response time improvements of Vista SP1 over Vista when using Windows Server
2003 OS on the servers. SP1 logged wins on 20 of the 25 tasks. Vista led on five tasks, showing a large win on
the Copy Q3 WAN-to-local task.
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Figure 3: Average response time improvements of Vista SP1 over Vista on a variety of file operations on four systems when
connected to servers running Windows Server 2003. Numbers greater than zero indicate Vista SP1 was more responsive.
Differences of more than 30 seconds are outside the yellow band.
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Figure 4 shows the percentage response time improvements of Vista SP1 over Vista when we tested with servers
running Windows Server 2003. Two of the file copy operations that move files from the Windows Server 2003
over the WAN to the local drive of the client system show large wins for Vista. Nine of the Vista SP1 wins and four
of the Vista wins were greater than 10 percent; all the Vista SP1 wins and all but two Vista wins were less than 50
percent.
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Figure 4: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations on four systems
when connected to servers running Windows Server 2003. Numbers greater than zero indicate Vista SP1 was more
responsive.
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Windows Server 2008 vs. Windows Server 2003 when copying files to and from a client
system running Vista SP1

Figure 5 displays the average response time improvements of Windows Server 2008 over Windows Server 2003
for the four projects that involve file copies either to or from the servers for four Vista SP1 systems. Windows
Server 2008 was faster on 17 tasks, often by a large amount, winning by over 11 minutes on one task and over 6
minutes on another. It led by over 25 minutes on the combined times of the 17 tasks. It showed the biggest wins
for Projects 2 and 3, which copy files to and from the WAN server. On the four remaining tasks, Windows Server
2003 was faster, but all the differences were small: the largest win was only 1.5 seconds. The combined times for
the four Windows Server 2003 wins was 3.4 seconds.
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Figure 5: Average response time improvements of Windows Server 2008 over Windows Server 2003 on a variety of file copy
operations on four Vista SP1 systems. Numbers greater than zero indicate Windows Server 2008 was more responsive.
Differences of more than 60 seconds are outside the yellow band. We describe each of those operations in the Scenario
descriptions section.

Figure 6 shows that Windows Server 2008 outperformed Windows Server 2003 on most of the file copy
operations in the four projects in this test that copy files to or from the servers The differences were dramatic for
Projects 2 and 3, which copy files to and from the WAN server; Windows Server 2008 wins ranged from 38.5
percent to 163.5 percent. Windows Server 2003 led on some of the local-to-local file copy tasks in Project 5 by a
high of 10.8 percent.
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Figure 6: Percentage response time improvements of Windows Server 2008 over Windows Server 2003 on a variety of file
copy operations on four Vista SP1 systems. Numbers greater than zero indicate Windows Server 2008 was more
responsive. We describe each of those operations in the Scenario descriptions section.

Test results

In the following subsection, we examine the test results by project. Because the charts in this subsection show
fewer operations, we have the space to label each operation by name. Appendix C contains a table of the
average times for each operation on each system.

Each result we report for a system is the average of five runs on that system. Before conducting the timed runs on
a given PC and OS combination, we ran the same workload three times on that system. We did so to allow each
OS to “learn” and, if possible, to tune itself for the work it would be facing. This approach allowed us to mimic
what would occur on many users’ PCs over the first few days they use their systems (and after each time they
introduce a new application into their work mix). See the Test methodology section for greater detail on how we
conducted the tests.

Project results for the comparisons of Vista SP1 and Vista when we tested with
Windows Server 2003

The figures in this section show the results for each of the five projects for the comparisons of Vista SP1 and
Vista when we tested with Windows Server 2003. The range for the y-axis that displays the percentage response
time difference varies from graph to graph based on the range of the results for that project for both server
operating systems. In each figure, the operations appear in the order in which they occurred in the projects.

The figures each provide two measures of the performance of two operating systems: average response time
differences in seconds and the percentage response time improvements. The labels above each column include
the difference in seconds between performance times for the two operating systems on a task. The columns
themselves show the percentage that time is of the total Vista task time. This percentage measure indicates the
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percentage of task time a user would save or lose on the two operating systems. To calculate the percentages,
we divided the difference in performance times of the two client operating systems by the Vista performance time.
The average and percentage response time measures together provide perspective on each difference, letting
you know both the actual time difference and the relative weight of that difference compared to the total task time.
The two measures together help indicate whether a response time difference would be noticeable to users.
Having the two measures is particularly useful because of the wide range of task times in this test. For example, a
2-second time difference is more noticeable to a user on a task that takes only a few seconds to complete than
that same difference would be on a task that takes minutes to complete.

Figure 7 compares the performance of Vista SP1 and Vista for the LAN-to-local file copy tasks in Project 1 when
using Windows Server 2003 as the server OS. Vista SP1 led on all five tasks in this project, copying the video
from the LAN to the local drive 22.3 seconds faster than Vista and the large Q3 folder 12.4 seconds faster.

The Vista SP1 times were from 13.6 percent to 19.3 percent faster than the Vista times on the tasks of this
project.
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Figure 7: Average response time improvements of Vista SP1 over Vista on a variety of file operations in Project 1 on four
systems when connected to servers running Windows Server 2003. Numbers greater than zero indicate Vista SP1 was more
responsive.
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Figure 8 compares the performance of Vista SP1 and Vista for the local-to-WAN file copy tasks in Project 3 when
using Windows Server 2003 as the server OS. Vista SP1 showed dramatic response time improvements on all of
these tasks, with leads ranging from 2.7 seconds to 26.8 seconds on the five operations in this project. Vista SP1
times on the project tasks were from 2.8 percent to 13.5 percent faster than Vista times.
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Figure 8: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 2 on four
systems when connected to servers running Windows Server 2003. Numbers greater than zero indicate Vista SP1 was more
responsive.
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Figure 9 compares the performance of Vista SP1 and Vista for the WAN-to-local file copy tasks in Project 3 when
using Windows Server 2003 as the server OS. Vista SP1 led on three tasks in this project by from 1.3 seconds to
20.3 seconds. Vista showed a multi-minute response time lead on the Copy Q3 WAN-to-local task in this project

and a 7-second lead on the zip file copy task.
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Figure 9: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 3 on four
systems when connected to servers running Windows Server 2003. Numbers greater than zero indicate Vista SP1 was more

responsive.
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Figure 10 compares the performance of Vista SP1 and Vista for the local-to-local file copy tasks in Project 4 when
using Windows Server 2003 as the server OS. Vista SP1 led by small margins on two of the tasks. Vista led on
the other two, copying the video 15.4 seconds (22.6 percent) faster and the Q3 folder 5.7 seconds (16.3 percent)
faster.
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Figure 10: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 4 on
four systems when connected to servers running Windows Server 2003. Numbers greater than zero indicate Vista SP1 was
more responsive.
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Figure 11 compares the performance of Vista SP1 and Vista for the local-to-LAN file copy tasks in Project 5 when
using Windows Server 2003 as the server OS. Vista SP1 showed faster response time on five of the six tasks in
this project. None of the response time differences for this project were dramatic; all were under three-fourths of a
second.
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Figure 11: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 5 on
four systems when connected to servers running Windows Server 2003. Numbers greater than zero indicate Vista SP1 was
more responsive.
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Project results for the comparisons of Vista SP1 and Vista when we tested with
Windows Server 2008

The figures in this section show the results for each of the five projects for the comparisons of Vista SP1 and
Vista when we tested with Windows Server 2008. The range for the y-axis that displays the percentage response
time difference varies from graph to graph based on the range of the results displayed in each graph. In each
figure, the operations appear in the order in which they occurred in the projects.

Figure 12 compares the performance of Vista SP1 and Vista for the LAN-to-local file copy tasks in Project 1 when
using Windows Server 2008 as the server OS. Vista SP1 showed response time improvements on all five tasks in
this project. Vista SP1 times were from just over 1 second to over 30 seconds faster and from 15.5 percent to
23.4 percent faster than Vista times.
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Figure 12: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 1 on
four systems when connected to servers running Windows Server 2008. Numbers greater than zero indicate Vista SP1 was
more responsive.
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Figure 13 compares the performance of Vista SP1 and Vista for the local-to-WAN file copy tasks in Project 2
when using Windows Server 2008 as the server OS. Vista SP1 led on all the tasks in this project, with wins
ranging from 7 seconds on the zip copy task to over 63 seconds on the copy Q3 local-to-WAN task. Vista SP1
was from 35.8 percent to 55.9 percent faster than Windows Vista on the project tasks.
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Figure 13: Average response time improvements of Vista SP1 over Vista on a variety of file operations in Project 2 on four
systems when connected to servers running Windows Server 2008. Numbers greater than zero indicate Vista SP1 was more

responsive.
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Figure 14 compares the performance of Vista SP1 and Vista for the WAN-to-local file copy tasks in Project 3
when using Windows Server 2008 as the server OS. Vista SP1 provided faster response time on all tasks in this
project, with wins ranging from 4 seconds on the zip folder copy task to over 110 seconds on the Q3 folder copy
task. The Vista SP1 times were from 30.1 percent to 63 percent faster than the Vista times on the tasks of this
project.
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Figure 14: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 3 on
four systems when connected to servers running Windows Server 2008. Numbers greater than zero indicate Vista SP1 was
more responsive.
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Figure 15 compares the performance of Vista SP1 and Vista for the local-to-local file copy tasks in Project 4 when
using Windows Server 2008 as the server OS. Vista led on two of the tasks in this project, by 12.8 seconds (18.7
percent) on the video copy task and by 3.8 seconds (10.5 percent) on the Q3 folder copy task.
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Figure 15: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 4 on
four systems when connected to servers running Windows Server 2008. Numbers greater than zero indicate Vista SP1 was

more responsive.
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Figure 16 compares the performance of Vista SP1 and Vista for the local-to-LAN file copy tasks in Project 5 when
using Windows Server 2008 as the server OS. All of the differences in this project, on which Vista was faster on 5
of the 6 tasks, were under or just over a second, amounts so small that we do not expect that they would be
noticeable to users.
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Figure 16: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 5 on
four systems when connected to servers running Windows Server 2008. Numbers greater than zero indicate Vista SP1 was
more responsive.
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Project results for the comparisons of Windows Server 2003 and Windows Server 2008
when we tested with Vista SP1

Figures in this section show the results for the four projects that copy data to or from the server. The range for the
y-axis that displays the percentage response time difference varies from graph to graph based on the range of the
results displayed in each graph.

Figure 17 compares the performance of Windows Server 2003 and Windows Server 2008 for the LAN-to-local file
copy tasks in Project 1 when using Vista SP1 as the client OS. Windows Server 2008 was faster on all five tasks
in this project. We expect that response time differences of less than 1 second would not be noticeable to users.
Windows Server 2008 exceeded that cutoff on two tasks, showing a 6.6 second difference on the video copy task
and a 1.6 second difference on the Q3 folder copy task. The percentage differences were small, from 1.6 percent
to 5.1 percent.
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Figure 17: Percentage response time differences between Windows Server 2008 and Windows Server 2003 on a variety of
file copy operations in Project 1 on four Vista SP1 systems. Project 1 operations copy files from the LAN server to the local

drive.
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Figure 18 compares the performance of Windows Server 2003 and Windows Server 2008 for the local-to-WAN
file copy tasks in Project 2 when using Vista SP1 as the client OS. Windows Server 2008 showed dramatic

performance differences over Windows Server 2003 on all of the tasks in this project, turning in times that ranged

from 29 seconds to over 817 seconds faster on the tasks in this project and beating the Windows Server 2003

times by from 62.1 percent to 85.3 percent.
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Figure 18: Percentage response time differences between Windows Server 2008 and Windows Server 2003 on a variety of

file copy operations in Project 2 on four Vista SP1 systems. Project 2 operations copy files from the local drive to the WAN

server.
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Figure 19 compares the performance of Windows Server 2003 and Windows Server 2008 for the WAN-to-local
file copy tasks in Project 3 when using Vista SP1 as the client OS. Windows Server 2008 demonstrated dramatic
performance differences over Windows Server 2003 on all of the tasks in this project, turning in times that ranged
from 8.5 seconds to 367.8 seconds faster on the tasks in this project. Windows Server 2008 scores were from
38.5 percent to 163.5 percent faster than the Windows Server 2003 times on the tasks in this project.
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Figure 19: Percentage response time differences between Windows Server 2008 and Windows Server 2003 on a variety of
file copy operations in Project 3 on four Vista SP1 systems. Project 3 operations copy files from the WAN server to the local
drive.
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Figure 20 compares the performance of Windows Server 2003 and Windows Server 2008 for the tasks in Project
5 when using Vista SP1 as the client OS. Only two of the wins in this project were greater than 1 second, our
cutoff for wins that would be noticeable to users. These two wins, one each for Windows Server 2003 and
Windows Server 2008 were both under 1.5 seconds and under 3 percent of the Windows Server 2003 task time.
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Figure 20: Percentage response time improvements of Vista SP1 over Vista on a variety of file operations in Project 5 on
four systems when connected to servers running Windows Server 2008. Numbers greater than zero indicate Windows
Server 2008 was more responsive.

Scenario descriptions

The file operations scenario covers part of the day of Bob, the head of Sales and Marketing at Acme Ventures, a
company that makes network hardware and provides network services, including installation and testing. Acme
Ventures has recently acquired a small company, WileyBeep, located across the country. Bob is planning an
upcoming training meeting at the WileyBeep headquarters. He has set aside most of a day to work on the training
materials and to update related collateral including a company brochure and a white paper. None of the materials
are in final form, most need to be rebranded with the Acme Ventures logo, and others need more extensive edits
by both Bob and lan, his co-presenter from WileyBeep.

This scenario models Bob’s copy and paste operations as he copies files for his presentation between the Acme
Ventures server and his local directory via the LAN, between the local directory and the WileyBeep server via the
WAN, and from one local directory to another. The scenario comprises five projects:

e Project 1: Bob copies files from the LAN server to his local drive. Bob starts the day by locating the
source files he needs on the Acme Ventures server and copying them into a working directory on his local
drive.
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e Project 2: Bob copies files from his local drive to the WAN server. During the day, he copies many of
the files and folders from Project 1 and a local zip folder into a folder on the WileyBeep server that he
accesses via that WAN.

e Project 3: Bob copies files from the WAN server to his local working directory. lan then edits the
files in this folder and adds other files, including a folder of WileyBeep staff pictures, to the folder that Bob
needs. Bob copies down the updated versions of the same files and folders from Project 2 (excluding the
Acme Ventures picture folder) to his local working directory.

e Project 4: Bob copies files between two folders on his local drive. At the end of the day, Bob copies
the edited versions of the same files and folders from Project 3 (excluding the two smallest folders) back
to another directory on his local system where he is collecting all presentation files.

e Project 5: Bob copy files from his local drive to the LAN server. At the end of the day, Bob copies the
edited versions of the same files and folders from Project 4 back to a folder on the Acme Ventures server
via the LAN.

Note: The scenario focuses on the file copy and paste operations that Bob executes during a day. Scenario
descriptions mention additional tasks such as the edits Bob makes to files and lan’s edit and copy tasks. Because
these tasks fall outside the scope of this study of copy and paste operations, we treat these tasks as occurring
“off-camera” and neither test nor give instructions for them. We switch to a different folder of files for the copy to
and paste from tasks. The folder contents are alike but the names are different.

Each of these projects involves a number of file copy and paste operations. The results of the scenario will be
times for each of these tasks.

The rest of this section describes each of Bob’s five projects. For each project, we include a brief summary of the
story behind the project, a list of the applications he uses in the project, a description of the content we propose to
use, and a list of tasks we will initially try to time.

Project 1: Bob copies files from the LAN server to his local drive

Story summary
Bob collects materials from locations on the Acme Ventures server, pulling them down to his local machine via the
LAN.

Applications
e Windows Explorer

Content
Bob individually copies the following items from various locations on the Acme Ventures server via the LAN to a
working folder on his local drive:

1. Training video—an approximately 1GB video that his staff created that demonstrates installing and
configuring Acme Ventures’ newest model network card. He wants WileyBeep staff to develop a library of
similar videos and later place them on YouTube.

2. Research white paper PowerPoint—an approximately 35MB folder containing seven versions of two
PowerPoint presentations ranging in size from approximately 2.3 MB to approximately 2.6 MB. These
PowerPoint presentations demonstrate the customer focused research and analysis Bob is hoping
WileyBeep staff will create for all products. Bob plans to display and discuss them in the training session,
but he first needs to lightly edit them and rebrand them with the new Acme Ventures/WileyBeep logo and
contact information.
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3. Q3 sales figures folder—an approximately 540MB folder containing 35 Excel, Access, and PowerPoint
files that Bob plans to use to create a Q4 sales report he has planned for the WileyBeep training session.
Files range in size from a 455KB Excel spreadsheet to a 412MB Access database; with the exception of
the Access database, they average approximately 3.7 MB.

4. Acme Ventures brochure folder—an approximately 50MB folder containing 11 versions of a Word
document and an Adobe Acrobat PDF of that document. The PDF files range in size from approximately
90KB to approximately 850KB and the Word documents range from approximately 1.75 MB to
approximately 5 MB.

5. Acme Ventures product pictures folder—an approximately 40MB folder containing 30 JPEG pictures of
Acme Ventures products. The files range in size from approximately 110KB to approximately 2.25 MB.
Bob wants to include product pictures in the Q4 sales presentation.

Instructions for project operations
Bob uses the following procedure to make his copies:

1. He opens a copy of Windows Explorer and browses to his working folder. We open Windows explore with
an exec command within the script.
2. For each copy, Bob uses the following procedure:
o Bob opens Windows Explorer to the parent folder and highlights the source file or folder.
o He presses Ctrl-C to copy the File or Folder.
o He clicks on the copy of Windows Explorer that is open to the destination folder.
o He presses Ctrl-V to paste the file into that folder. We time the paste operation.

Project 2: Bob copies files from his local drive to the WAN server

Story summary

During the day, Bob and lan pass their edit passes on the Acme Ventures brochure and the training session
outline back and forth over the WAN. At the beginning of the day, Bob copies some of the same files he copied to
his local working directory in Project 1 to lan’s working directory on the WAN server. He also copies a zip folder of
report templates that he wants to share with the WileyBeep office.

Applications
e Windows Explorer

Content
Bob copies the following files and folders:

1. Research white paper PowerPoint—an approximately 35MB folder containing 14 PowerPoint files
ranging in size from 2.3 MB to 2.6 MB

2. Q3 sales figures folder—an approximately 540MB folder containing 35 Excel, Access, and PowerPoint
files

3. Acme Ventures brochure folder—an approximately 50MB folder containing 11 versions of Word
document and an Adobe Acrobat PDF of that document

4. Acme Ventures product pictures folder—an approximately 40MB folder containing 30 JPEG pictures of
Acme Ventures products

5. Zipped folder—an approximately 18MB zipped folder

Instructions for project operations
Bob uses the following procedure to make his copies:

1. He opens a copy of Windows Explorer which opens by default to his working folder.

2. For each copy, Bob uses the following procedure:
o Bob opens Windows Explorer to the parent folder and highlights the source file or folder.
o He presses Ctrl-C to copy the File or Folder.
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o He clicks on the copy of Windows Explorer that is open to the destination folder on the remote

machine.
o He presses Ctrl-V to paste the file into that folder. We time the paste operation.

Project 3: Bob copies files from the WAN server to his local working directory

Story summary

During the day, Bob and lan pass their edit passes on the presentation materials back and forth over the WAN.
After lan finishes each edit pass, he puts edited files back into a working folder on the WileyBeep server and
alerts Bob. Bob then copies each edited file or folder individually to his own local working directory via the WAN.
Throughout the day, lan also puts other materials into that directory that Bob needs.

Applications
e Windows Explorer

Content
During the course of the day, Bob pulls down the following files and folders that now include lan’s edits:

1. Research white paper PowerPoint—an approximately 35MB folder containing 14 PowerPoint files
ranging in size from 2.3 MB to 2.6 MB

2. Qa3 sales figures folder—an approximately 540MB folder containing 35 Excel, Access, and PowerPoint
files

3. Acme Ventures brochure folder—an approximately 50MB folder containing 11 versions of Word
document and an Adobe Acrobat PDF of that document

4. WileyBeep product pictures folder—an approximately 40MB folder containing 30 JPEG pictures of
WileyBeep products. lan assembled these pictures for Bob to use in the brochure.

5. Zipped folder—an approximately 18MB zipped folder

Instructions for project operations
Bob uses the following procedure to make his copies:

1. He opens a copy of Windows Explorer which opens by default to his working folder.
2. For each copy, Bob uses the following procedure:
o Bob opens Windows Explorer to the parent folder and highlights the source file or folder on the
remote machine.
o He presses Ctrl-C to copy the File or Folder.
o He clicks on the copy of Windows Explorer that is open to the destination folder on the local machine.
o He presses Ctrl-V to paste the file into that folder. We time the paste operation.

Project 4: Bob copies files between two folders on his local drive

Story summary

Bob makes another edit pass through each of the documents he gets back from lan and saves them to his
working directory. As he finishes each file, he copies it from that working directory to another local directory where
he is saving the latest version of each presentation file.

Applications
e Windows Explorer

Content
During the course of the day, Bob copies the following files and folders from the one local directory to the other:

1. Training video—an approximately 1GB video
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2. Q3 sales figures folder—an approximately 540MB folder containing 35 Excel, Access, and PowerPoint
files

3. Acme Ventures brochure folder—an approximately 50MB folder containing 11 versions of Word
document and an Adobe Acrobat PDF of that document

4. WileyBeep product pictures folder—an approximately 40MB folder containing 30 JPEG pictures of
Acme Ventures products

Instructions for project operations
Bob uses the following procedure to make his copies:

1. He opens a copy of Windows Explorer and browses to his working folder.
2. For each copy, Bob uses the following procedure:
o Bob opens Windows Explorer to the parent folder and highlights the source file or folder.
o He presses Ctrl-C to copy the File or Folder.
o He clicks on the copy of Windows Explorer that is open to the destination folder.
o He presses Ctrl-V to paste the file into that folder. We time the paste operation.

Project 5: Bob copy files from his local drive to the LAN server

Story summary
When Bob and lan finish working with each file or folder, Bob copies them from his local directory to the Acme
Ventures server via the LAN.

Applications
Windows Explorer

Content
Bob individually copies the following files and folders from his local drive via the LAN to the Acme Ventures
server:

1. Training video—an approximately 1GB video

2. Research white paper PowerPoint—an approximately 35MB folder containing 14 PowerPoint files
ranging in size from 2.3 MB to 2.6 MB

3. Q3 sales figures folder—an approximately 540MB folder containing 35 Excel, Access, and PowerPoint
files

4. Acme Ventures brochure folder—an approximately 50MB folder containing 11 versions of Word
document and an Adobe Acrobat PDF of that document

5. WileyBeep product pictures folder—an approximately 40MB folder containing 30 JPEG pictures of
Acme Ventures products

6. Zipped folder—an approximately 18MB zipped folder

Instructions for project operations
Bob uses the following procedure to make his copies:

1. He opens a copy of Windows Explorer and browses to his working folder.
2. For each copy, Bob uses the following procedure:
o Bob opens Windows Explorer to the parent folder and highlights the source file or folder on the
local system.
o He presses Ctrl-C to copy the File or Folder.
o He clicks on the copy of Windows Explorer that is open to the destination folder on the Acme
Ventures server over the LAN.
o He presses Ctrl-V to paste the file into that folder. We time the paste operation.
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Test methodology

PT developed the scenarios and the test script we used for this evaluation. The script uses ScenCap to execute a
variety of common operations and runs on both versions of Vista. ScenCap is a Microsoft-developed application
that uses the Windows accessibility interfaces to create and replay scenarios containing user actions. ScenCap
also lets developers mark the start and end times of functions it performs.

Software this test requires
This test requires licensed copies of Vista OS for the clients and a Windows Server OS for the servers. We used
the following OS versions:

Microsoft Windows Server 2003 R2 Enterprise Edition

Windows Server 2008 RTM Enterprise (Build 6001.080118-1840)

Windows Vista Ultimate Version 6.0, build 6000

Windows Vista Ultimate version 6.0, build 6001, Service Pack 1, build 17128

In our tests, we used Symantec Norton Ghost 2003 to create sector-by-sector disk images of the systems after
we had installed the OS. We created one image for Vista and one for Vista SP1 for each test system. Before
testing, we used Norton Ghost 2003 to restore the appropriate image to the hard drive on the test system.

We installed and ran a licensed copy of Shunra VE Desktop v2.6 Build 1060.001 on the WAN servers and used it
to add 100ms round trip latency to the 100Mb/s network in order to simulate WAN conditions.

Hardware this test requires

All test systems must meet Microsoft's Windows Vista Ready requirements (Source: hitp://www.microsoft.com/
windows/products/windowsvista/buyorupgrade/capable.mspx). In addition, each must have a network adapter and
a valid network path to the LAN and WAN servers. We recommend that all machines under test have the latest
available drivers for their particular hardware configuration.

Each test bed also requires two identically configured servers and a network switch. We connected the servers
and test systems with a NETGEAR ProSafe 16 Port 10/100 Switch (FS116) via an Ethernet adapter.

Setting up the test servers

For the Windows Server 2003 test bed, we began by installing a fresh copy of Microsoft Windows Server 2003 R2
Enterprise Edition, Service Pack 2 on each server as follows:

We used the default BIOS settings on all servers.

Assign a computer name of WANSERVER or LANSERVER.

Enter a password1 for the administrator logon.

Select Eastern Time Zone.

Use typical settings for the Network installation.

Use “workgroup” for the workgroup.

Connect the servers to the NETGEAR ProSafe 16 Port 10/100 Switch (FS116) via an Ethernet adapter.
Set the IP address to 192.168.168.11 for WANSERVER and 192.168.168.10 for LANSERVER.

NGO~ LON =

Use the following process to install Shunra VE Desktop on the WAN server for the Windows Server 2003 test
bed:

1. Download the Shunra VE Desktop Installation folder to the Desktop.
Install Shunra VE Desktop:
a. Open the Shunra VE Desktop installation folder.
b. Open the Standard Edition (full version) folder.
c. Open the VEDesktop folder.
d. Double-click the VE-Desktop_Setup.exe file.
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At the Welcome to the InstallShield Wizard dialog box, click Next.

At the License Agreement dialog box, click Yes.

At the Shunra VE Desktop Client v2.6 Readme dialog box, click Next.

At the Choose Destination Location dialog box, click Next.

At the InstallShield Wizard Complete dialog box, click the radio button next to Yes, | want to restart
my computer now and click Finish.

We applied updates from the Microsoft Windows Update site. Appendix C lists the updates.

For the Windows Server 2008 test bed, we began by installing a fresh copy of Microsoft Windows Server 2008
RTM Enterprise (Build 6001.080118-1840) on each server as follows:

Nooh~wb =

Assign a computer name of WANSERVER or LANSERVER.

Enter a password1 for the administrator logon.

Select Eastern Time Zone.

Use typical settings for the Network installation.

Use “workgroup” for the workgroup.

Connect the servers to the NETGEAR ProSafe 16 Port 10/100 Switch (FS116) via an Ethernet adapter.
Set the IP address to 192.168.168.11 for WANSERVER and 192.168.168.10 for LANSERVER.

Use the following process to install Shunra VE Desktop on the WAN server for the Windows Server 2008 test

bed:

1.
2

Download the Shunra VE Desktop Installation folder to the Desktop.
Install Shunra VE Desktop:

mS@mo o0 T

Open the Shunra VE Desktop installation folder.

Open the Standard Edition (full version) folder.

Open the VEDesktop folder.

Double-click the VE-Desktop_Setup.exe file.

At the Welcome to the InstallShield Wizard dialog box, click Next.

At the License Agreement dialog box, click Yes.

At the Shunra VE Desktop Client v2.6 Readme dialog box, click Next.

At the Choose Destination Location dialog box, click Next.

At the InstallShield Wizard Complete dialog box, click the radio button next to Yes, | want to restart
my computer now and click Finish.

Setting up a system for test using these scripts
To get the most accurate and repeatable results possible, you must set up all test systems carefully, starting with
a clean hard disk. Each test system must be able to access the Internet during setup so it can download software
updates.

Installing Microsoft Windows Vista Ultimate
Use the following process to install a clean version of Windows Vista Ultimate with updated drivers and Windows
Updates on each system under test:

1.

Install Windows Vista Ultimate Build 6000.

@ oo oTw

Boot to a Windows Vista Ultimate Build 6000 DVD.

When prompted to press any key to boot from CD or DVD, press any key.

At the language and preference screen, accept the default options, and click Next.
Click Install now.

Do not enter a Product key. Uncheck Automatically activate Windows when I'm online, and click Next.

At the Do you want to enter your product key now screen, click No.
Select Windows Vista Ultimate, and check | have selected the edition of Windows that | purchased.
Click Next.
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Check | accept the license terms, and click Next.
Select Custom (advanced) at the Which type of installation do you want screen.
Click Drive options (advanced).
Select the Disk you want to install Windows Vista Ultimate on, and click Format.
At the All data stored will be permanently deleted dialog, click OK.
. Once the system finishes formatting the disk, click Next.
Leave the password blank. Type User in the Username field, and click Next.
Type a computer name, and click Next.
Click Use recommended settings.
Select the correct Time zone, date, and time, and click Next.
At the Select your computer’s current location screen, click Public location.
Click Start at the Thank you screen.
When the Windows Vista installation completes, close the Welcome Center Dialog.
At the Set network location screen, click Public location, and click Close.
|sable Hide extensions for known file types and set up folders.
On the desktop, click Start, Computer.
Select Organize>Folder and Search Options.
Select the View tab.
Uncheck Hide extensions for known file types.
Uncheck Use check boxes to select if it is not already unchecked.
Check Show hidden files and folders.
Click OK.
Select Organize>Layout>Menu Bar. (Note: When you finish, the Menu Bar should appear on the
folder view.)

i. Inthe address bar, type C:\ and press Enter.

j. The script will not run if the Folder view is collapsed in the lower left-hand pane. If it is collapsed, click
the up arrow to reopen the Folder view.

3. Close the Explorer window.

4. Change the Power Options.

Click Start>Control Panel.

Click Hardware and Sound.

Click Power Options.

Under Preferred plans, High Performance, click Change plan settings.

Verify that Turn off the display and Put the computer to sleep options are set to Never. Note: If you
make changes to these settings, click Save changes, and then click Change plan settings under High
Performance.

Click Change advanced power settings.

Click the plus (+) sign next to Additional settings. Change the Require a password on wakeup setting
to No. If the machine is a laptop, change this setting to No for both On battery and Plugged in.

h. Click OK.

i. Click File=>Close to exit the Edit Plan Settings dialog.

5. Verify that Windows Aero is the default color scheme.

a. Right-click the desktop and select Personalize.

b. Click Window Color and Appearance.

c. If an Appearance Settings dialog with a Color scheme drop-down appears, select Windows Aero from
the Color Scheme drop-down list, and press OK. If instead a Windows Color and Appearance dialog
displays, then Windows Aero is already the default Color Scheme.

6. Turn off Windows Security Center Pop-up Alerts. Doing so prevents such alerts from occurring during
testing and affecting results.

Open the system Control Panel.

Double-click Security Center.

Click Change the way Security Center Alerts me on the left.

Uncheck Firewall, Automatic Updates, and Virus Protection.

Click OK.

Close the Security Center main page.
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7. Verify that Windows Automatic Updates are off. Turning off Windows Automatic Updates prevents such
updates from occurring during testing and affecting results. (We would have preferred to set the updates
to occur at a far future date, but we are not aware of an option for doing so.)

a. Click Start.
b. Right-click My Computer, and select Properties.
c. Select the Automatic Updates tab.

8. Change the IP address to 192.168.168.31 (mask 255.255.255.0)

Open Control Panel.

Open Network and Sharing Center.

Click on Manage network connections.

Right-click Local area connection and select Properties.

At the security dialog, select Continue.

Select Internet Protocol Version 4 and select Properties.

Enter 192.168.168.31 for the IP address and 255.255.255.0 for the subnet mask.

Click OK, and exit the network settings.

dd the servers to the hosts file.

Click Start>All Programs—> Accessories. Right-click Notepad-> Select Run as Administrator to open

Notepad as Administrator.

b. Click File>Open and enter C:\windows\system32\drivers\etc\hosts.

c. At the bottom of the list of hosts, add the following on separate lines:
192.168.168.10 lanserver
192.168.168.11 wanserver

d. Close Notepad, and click Yes to save changes.

pPoSE 00T

Installing Microsoft Windows Vista Ultimate Service Pack 1
Use the following process to apply Windows Vista Critical and Recommended Updates and driver updates and
then install Windows Vista Ultimate Service Pack 1 on the Vista Image:

1. Install all Windows Vista Critical and Recommended Updates and driver updates from the Microsoft
Updates site.

2. Install available driver updates form vendor Web sites.

3. Install Windows Vista SP1

Insert the Windows Vista Service Pack 1 update DVD.

In Computer\DVD Drive (D:), double-click the Windows 6.0-KB936330-X86 executable file.

At the User Account Control dialog box, click Continue.

At the Install Windows Service Pack dialog box, click Next.

Check | accept the license terms, and click Next.

Close any open programs, and click Install. The installation will take up to 1 hour.

At the Installation was successful dialog box, click Finish.

@ oo

Copylng the code and content files to the system under test
Unzip the PTVistaXPPerf code and content file (PTVistaXPPerf.zip).
2. Copy the PTVistaXPPerf code and content folder (PTVistaXPPerf) to the C:\PTVistaXPPerf folder.
3. Create a share named SALES on the LANSERVER. Copy the contents of the LANSERVER folder to that
share.
4. Create a share named SALES on the WANSERVER. Copy the contents of the WANSERVER folder to
that share.

Installing PTVistaXPPerf on the system under test

Use the following process to install PTVistaXPPerf on the Windows Vista test systems:

1. The release files include three folders, one each for the test system and the LAN and WAN servers.
a. Copy the PTVistaXPPerf folder to the C: drive on the test system.
b. Copy the contents of the LANSERVER folder to the root of \LANSERVER\sales (E:\sales).
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3.
4.

5.

c. Copy the contents of the WANSERVER folder to the root of \WWANSERVER\sales (E:\sales)

Bring up a command-line interface, which you will use to perform the rest of this installation.

a. Click Start->All Programs—>Accessories. Right-click Command Prompt-> Select Run as Administrator
to open the command-line interface window as Administrator.

Type cd\PTVistaXPPerf, and press Enter.

Type setupfilecopy, and press Enter.

The test script will now install on the system.

The setup script reboots the system as the final setup step.

Running the test script
Use the following process to get the test bed ready to run the test:

1.

2.
3

Use Norton Ghost 2003 to restore the appropriate image (either Windows Vista or Windows Vista SP1) to
the hard drive on the test system.

Start both servers.

Verify that the network is correct (either Server 2003 or Server 2008).

Use the following process to run Shunra VE Desktop on the WAN server in order to create round trip latency of

100 ms.

Pon-~

Click Start>All Programs—>Shunra VE Desktop Client>VE Desktop Client.
Right-click the Shunra VE Desktop icon in the System Tray, and click Open.
Set the sliding Latency button to Low.

Click Play.

Use the following process to run the test script on the Windows Vista test systems:

1. Reboot the system.

2. Bring up a command-line interface, which you will use to run the script.

a. Click Start>All Programs—>Accessories. Right-click Command Prompt-> Select Run as Administrator
to open the command-line interface window as Administrator.

3. Type cd\PTVistaXPPerf, and press Enter.

4. Type run -p -results c:\results (to set the directory in which the tool will place its results), and
press Enter.

5. Click Start->All Programs—->Accessories. Right-click Command Prompt->Select Run as Administrator to
open the command-line interface window as Administrator.

6. Torunthe scenariotype run -1 1 -s 8 -ir 1 -nopurge 1 -wab 300 -scenariotype
filecopy -label [MachineNameandOS], and press Enter. (This command runs the FileCopy
Scenario a total of eight times: one run after rebooting, one run after return from standby, and one run
immediately after the previous run. It waits 300 seconds after an initial reboot before starting, does not
purge memory, and identifies the results files with MachineNameandOS.)

7. At the completion of the run, check the results in c:\results. Each set of results is in a separate
subdirectory there. A status.ixt file states whether the set of runs passed or failed. A log file gives
information about the run, including an error message for failed sets of runs. The IndividualRunCSy folder
includes a CSV file containing the results for the set of runs.
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Appendix A—Test system configurations

This appendix includes a diagram of the test beds we set up for this testing and provides detailed configuration
information about the client test systems and about the computers we used as LAN and WAN servers.

Test bed configurations

For testing, we built four identically configured servers and put two in each of two test beds. This allowed us to
test two clients at the same time, one in each test bed. Figure 22 diagrams the Windows Server 2003 test bed.
For each test, we ran with either Windows Server 2003 or Windows Server 2008 on both test bed servers and

with Shunra VE Desktop on the WAN server. Figure 21 diagrams the Windows Server 2003 test bed and Figure
22 the Windows Server 2008 test bed.

Windows Server 2003 Testbed

100MB Ethernet
Switch

System Under Test

LAN Server
Windows Server 2003 R2 Enterprise

Simulated 100Mb/s WAN

WAN Server
Windows Server 2003 R2 Enterprise
running WAN Simulator software 100MB Ethernet e
connection
Figure 21: Windows Server 2003 test bed diagram.
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Windows Server 2008 Testbed

100MB Ethernet
Switch

LAN Server

WAN Server
Windows Server 2008 Enterprise
running WAN Simulator software

Windows Server 2008 Enterprise

Simulated 100Mb/s WAN

System Under Test

connection

100MB Ethernet

Figure 22: Windows Server 2008 test bed diagram.
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Test client system configurations
Figure 23 provides detailed configuration information about each of the test systems, which we list in alphabetical

order.

System

Dell XPS M170

Dell XPS 600

HP d4100e

Toshiba Tecra
M4

General

Processor and OS
kernel: (physical,
core, logical)/(UP,
MP)

1P1C1L/ UP

1P2C2L / MP

1P2C2L / MP

1P1C1L/ UP

Number of physical
processors

1

1

1

1

Single/dual-Core
processors

Single

Dual

Dual

Single

Processor HT Status

NA

NA

NA

NA

System Power
Management Policy

High performance

High performance

High performance

High performance

Notebook processor

Enhanced Intel

Enhanced Intel

ower saving option | SPeedStep NA NA SpeedStep
P gop Technology Technology
Notebook dimensions - in o o » b 41/
(Length x Width x zriﬁ) ’1‘21,,1({;;; )2 NA NA (1r?1inx) 1112 ’(‘r:a/j()
Height)
Notebook weight 8 Ibs. 10 oz. NA NA 6 Ibs. 2 0z.
CPU
System type Laptop Desktop Desktop Tablet PC
Vendor Intel Intel AMD Intel
Name Pentium M 760 Pentium D 940 Athlon 64 X2 3800+ | Pentium M 740
Stepping 8 2 1 8
Socket type mPGA-479M LGA775 Socket 939 mPGA-479M
Core frequency
(GHz) 2.0 3.2 2.0 1.73
. 2,000 MHz
Front-side bus ’
533 800 HyperTransport 533
frequency (MHz) Technology
L1 cache 32KB+32KB | 16 KB+ 12Kuops | o K0 *O4KBPEr 37434 32kp
L2 cache 2 MB 2 MB 512 KB per core 2 MB
Platform
vendorandmodel | peii xps M170 | Dell XPS 600 HP d4100e Toshiba Tecra M4
Motherboard model Asus Amberine Toshiba Portable
number Dell 0F8460 Dell OUH741 ABAE-LE PC

Motherboard chipset

Intel iI915PM/GM

NVIDIA nForce4
SLi Intel Edition

ATI Radeon Xpress
200 (RS480)

Intel iI915PM/GM

Motherboard revision

version (Vista SP1)

03 A3 10 03
number
Motherboard serial 8MV5S91 3YRJS91 MXG61802G4NAG6 46053511H
number 0
BIOS name and Dell AO5 Dell A11 Phoenix v3.15 Toshiba v2.03
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Toshiba Tecra

System Dell XPS M170 Dell XPS 600 HP d4100e M4
BIOS name and Dell AO5 Dell A11 Phoenix v3.14 Toshiba v2.03
version (Vista)
BIOS settings Default Default Default Default
Memory module(s)
Hyundai Hyundai
Vendor and model Electronics Samsung M3 Infineon Electronics
number HYMP564S64BP6 | 78T2953CZ3-CE6 | 64D64320HUSC HYMP564S64BP6
-C4 -C4
Type PC2-4200 PC2-5300 PC3200 PC4200
Speed (MHz) 533 667 400 533
Speed running in the
system (MHz) 266 333 200 266
Timing/Latency (tCL-
{RCD-tRP-tRASMIn) 4-4-4-12 5-5-5-13 3-3-3-8 4-4-4-12
Size 1 GB 2 GB 1 GB 1 GB
Number of memory | 5, 515 \g 2x1GB 2x 512 MB 2 x 512 MB
module(s)
Chip organization Double-sided Double-sided Double-sided Double-sided
Channel Dual Dual Dual Dual
Hard disk
Vendor and model Fujitsu Seagate Seagate Toshiba
number MHV2080AH ST3160828AS ST3160023AS MK4032GSX
Number of disks in
1 1 1 1
system
Size 80 GB 160 GB 160 GB 40 GB
Buffer Size 8 MB 8 MB 8 MB 8 MB
RPM 5,400 7,200 7,200 5,400
Type Ultra ATA SATA 300 Mb/s SATA 150 Mb/s SATA 150 Mb/s
Controller '(?5_"2_2,\%) TFBM | hForced MCP ATI SB400 '(?3_"2_2,\%) 1FBM
Driver (Vista SP1) Microsoft Microsoft Microsoft Microsoft
6.0.6001.17128 6.0.6001.17128 6.0.6001.17128 6.0.6001.17128
Driver (Vista) Microsoft Microsoft Microsoft Microsoft
6.0.6000.16387 6.0.6000.16386 6.0.6000.16386 6.0.6000.16387
Graphics
Vendor and model NVIDIA GeForce NVIDIA GeForce NVIDIA GeForce NVIDIA GeForce
number Go 7800 GTX 7800 GTX 7300 LE Go 6200 TE
Chipset g%F(orce Go 7800 g%F(orce 7800 GeForce 7300 LE _(?EForce Go 6200
BIOS version 5.70.02.19.12 5.70.02.11.15 5.72.22.34.21 5.43.02.49.E2
Type PCI-E PCI-E PCI-E PCI-E
Memory size 256 MB 256 MB 256 MB 64 MB
Resolution 1,920 x 1,200 1,280 x 1,024 1,280 x 1,024 1,400 x 1,050
Driver (Vista SP1) NVIDIA NVIDIA NVIDIA NVIDIA
7.14.10.9686 7.15.11.6371 7.14.10.9687 7.14.10.9686
Driver (Vista) NVIDIA NVIDIA NVIDIA NVIDIA
7.14.10.9686 7.14.10.9686 7.14.10.9686 7.14.10.9686
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System Dell XPS M170 Dell XPS 600 HP d4100e T°5h'mTe°’a
Audio
Vendor and model SigmaTel C-Major | Creative SB SoundMax
. . Realtek AC’97 Integrated Digital
number Audio Audigy 2ZS >
Audio
. . Realtek .
. : SigmaTel Creative . Analog Devices
Driver (Vista SP1) | 530.0.4255 6.0.1.1220 Semiconductor 5.12.1.5240
6.0.1.6183
. . Realtek :
. ) SigmaTel Creative . Analog Devices
Driver (Vista) 5.10.0.4255 6.0.1.1220 Semiconductor 5.12.1.5240
6.0.1.6183
Ethernet
NVIDIA nForce Marvell Yukon
Vendor and model | Broadcom 570x | o orking Realtek RTL8139 | 88E8053 Gigabit
number Gigabit Controller
Controller Controller
Type Integrated Integrated Integrated PCI-E
. . Microsoft NVIDIA Microsoft .
Driver (Vista SP1) | 15 10.0.1 65.7.4.0 5.640.630.2006 Microsoft 9.0.32.3
. . . Microsoft Microsoft ,
Driver (Vista) Microsoft 9.20.0.3 6.20.126 5 640.630 2006 Microsoft 9.0.32.3
Modem
Vendor and model Conexant D110 Conexant D850 Toshiba Software
56K V.90 DFVc NA
number MDC V.9x Modem
Modem
Driver (Vista SP1) Microsoft 7.39.6.1 | Microsoft 7.39.6.1 | NA Microsoft 2.1.69.0
Driver (Vista) Microsoft 7.39.6.0 | Microsoft 7.39.6.0 | NA Microsoft 2.1.69.0
Optical drive(s)
Vendor and model TSSTcorp TSSTcorp TS- .
number TSL462C Sony DDU1615 H552D Matshita UIDA750
DVD-ROM/CD- DVD-ROM/CD-
Type RW DVD-ROM DVD-RW RW
Single / Dual Layer NA NA Dual NA
USB ports
Number of ports 6 8 6 3
Type of ports
(USB1.1, USB2.0) USB2.0 USB2.0 USB2.0 USB2.0
IEEE 1394 ports
Number of ports 1 |3 | 2 [ 1
Monitor
ViewSonic ViewSonic Optiquest
CRT/LCD UXGA LCD Optiquest Q7 Q7 SXGALCD
Screen size 17” 17” 17” 14.1”
Refresh rate 60 Hz 60 Hz 60 Hz 60 Hz
Wireless
. Intel
Vendor and model Intel PRO/Wireless NA NA PRO/Wireless
number 2200BG 2200BG
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Toshiba Tecra

System Dell XPS M170 Dell XPS 600 HP d4100e M4

. . Microsoft Microsoft
Driver (Vista SP1) 9.1.0.104 NA NA 9.1.0.104

. . Microsoft Microsoft
Driver (Vista) 9.1.0.104 NA NA 9.1.0.104
Battery
Type Lithium lon NA NA Lithium lon
Size (Length x Width | g1/, 30 4> NA NA 5 x 2% x 1"

x Height)

. 7,200 mAh/11.1V 4,700 mAh / 10.8V

Rated capacity 8OWHr NA NA 50WHr
Weight 11b. NA NA 11 oz.

Figure 23: Client system configurations
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Test server configurations

Figure 24 provides detailed configuration information about the test servers. We built four identically configured
servers so that we could test two clients at a time each in a test bed with a LAN and WAN server.

Test server we built

General

Processor and OS kernel: (physical, core, logical) /

(UP, MP) 1P,2C,2L/MP
Number of physical processors 1
Single/Dual-Core processors Dual

System Power Management Policy (Windows Server
2008)

High performance (always on)

System Power Management Policy (Windows Server

High performance (always on)

2003)

CPU

Vendor Intel

Name Core 2 Duo
Model number E6400

Stepping 6

Socket type 775 LGA

Core frequency (GHz) 213

Front-side bus frequency (MHz) 1066

L1 cache 32 KB + 32 KB (per core)
L2 cache 2048 KB (shared)
Platform

Vendor Intel

Motherboard model number Intel DQ965GF
Motherboard chipset Intel Q965
Motherboard revision number C1

Motherboard serial number BQGF64300DXU

BIOS name and version

Intel CO96510J.86A.4462.2006.0804.2059

BIOS settings

Setup Default

Memory module(s)

Vendor and model number

Samsung M378T2953EZ3-CE6

Type

PC2-5300 DDR2

Speed (MHz) 667

Speed running in the system (MHz) 667

Timing/Latency (tCL-tRCD-tRP-tRASmin) 5-5-15-20

Size 2x1,024 MB

Number of memory module(s) 2

Chip organization Double-sided

Channel Dual

Hard disk OS

Vendor and model nhumber Seagate ST3320620AS
Size 320 GB

Buffer size 16 MB

RPM 7,200

Type SATA 300 Mb/s
Controller Intel 82801HO (ICH8DO)

Controller driver (Windows Server 2008)

Microsoft 6.0.6001.17051

Controller driver (Windows Server 2003)

Microsoft 5.2.3790.0

Hard disk data
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Test server we built

Vendor and model number Seagate ST3500320AS
Size 500 GB

Buffer size 32 MB

RPM 7,200

Type SATA 300 Mb/s
Controller Intel 82801HO (ICH8DO)

Controller driver (Windows Server 2008)

Microsoft 6.0.6001.17051

Controller driver (Windows Server 2003)

Microsoft 5.2.3790.0

Operating system Windows Server 2008

Name

Microsoft Windows Server 2008 Enterprise

Build number

6001

Service pack SP1

File system NTFS

Kernel ACPI Multiprocessor PC
Language English

Microsoft DirectX version 10

Operating system Windows Server 2003

Name

Microsoft Windows Server 2003 R2 Enterprise Edition

Build number

3790

Service pack SP2

File system NTFS

Kernel ACPI Multiprocessor PC
Language English
Microsoft DirectX version 9.0c

Graphics

Vendor and model number Intel GMA 3000
Type Integrated
Chipset Intel GMA 3000
BIOS version 1348

Memory size 128 MB
Resolution 1,280 x 1,024

Driver (Windows Server 2008)

Intel 6.14.10.4864

Driver (Windows Server 2003)

Microsoft 5.2.3790.0

Sound card/subsystem

Vendor and model number N/A
Driver (Windows Server 2008) N/A
Driver (Windows Server 2003) N/A

Ethernet

Vendor and model number

Intel Pro/1000 GT Desktop Adapter

Driver (Windows Server 2008)

Intel 8.2.17.0

Driver (Windows Server 2003)

Intel 8.9.1.0

Optical drive(s)

Vendor and model number

TSSTcorp SH-S183L

Type DVD/CD-ROM (RW)
Interface SATA

Dual/Single layer Dual Layer

USB ports

Number 10

Type 2.0

IEEE 1394

Number | 1
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Test server we built

Monitor

Type ViewSonic Optiquest Q7
Screen size 177

Refresh rate 60 Hz

Figure 24: Test server configurations

Principled Technologies, Inc.: Responsiveness of Windows Vista™, and Windows Vista™ SP1 using

Windows Server 2003™ and Windows Server 2008™ on common business file tasks

40



Appendix B—Windows updates

This appendix lists all the updates we applied to the test systems and servers from the Windows Update site.
Figure 25 lists the Windows Vista updates that we installed on each test system.

Windows Vista Critical and Recommended Updates

Definition Update 1.14.1652.4 for Beta Windows Defender (KB915597)

Windows Update software 6.0.5520.16388

Figure 25: The Windows Vista updates we applied to each test system.

Figure 26 lists the Windows Vista updates that we installed on each test system prior to installing Windows Vista
Service Pack 1 and running the Windows Vista SP1 tests.

Windows Vista SP1 Critical and Recommended Updates (applied on 01/08/2008)

Service Pack for Microsoft Windows (KB936330)

Update for Microsoft Windows (KB938371)

Update for Microsoft Windows (KB935509)

Update for Microsoft Windows (KB937954)

Update for Microsoft Windows (KB937287)

Cumulative Update for Media Center for Windows Vista (KB941229)

Cumulative Update for Media Center for Windows Vista (KB935652)

Hotfix for Microsoft Windows (KB932471)

Security Update for Microsoft Windows (KB925902)

Security Update for Microsoft Windows (KB929123)

Security Update for Microsoft Windows (KB929916)

Security Update for Microsoft Windows (KB930178

Security Update for Microsoft Windows (KB931213

Security Update for Microsoft Windows (KB933579

Security Update for Microsoft Windows (KB933729

Security Update for Microsoft Windows (KB935807

Security Update for Microsoft Windows (KB936021

Security Update for Microsoft Windows (KB936782

Security Update for Microsoft Windows (KB938127

Security Update for Microsoft Windows (KB941202

Security Update for Microsoft Windows (KB941568

Security Update for Microsoft Windows (KB941569

Security Update for Microsoft Windows (KB942615

= I~ = [~ =~ = s = s = s = =

Security Update for Microsoft Windows (KB942624

)
)
)
)
)
;
Security Update for Microsoft Windows (KB938123)
)
)
)
)
)
)
)

Security Update for Microsoft Windows (KB943078

Update for Microsoft Windows (KB905866)

Update for Microsoft Windows (KB929399

Update for Microsoft Windows (KB929735

Update for Microsoft Windows (KB930857

Update for Microsoft Windows (KB931099

Update for Microsoft Windows (KB931573

Update for Microsoft Windows (KB935280

Update for Microsoft Windows (KB936357

Update for Microsoft Windows (KB936824

Update for Microsoft Windows (KB936825

( )
( )
( )
e
Update for Microsoft Windows (KB933928)
( )
( )
( )
( )
( )

Update for Microsoft Windows (KB938194
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Windows Vista SP1 Critical and Recommended Updates (applied on 01/08/2008)

Update for Microsoft Windows (KB938952

Update for Microsoft Windows (KB938979

Update for Microsoft Windows (KB941600

Update for Microsoft Windows (KB941651

Update for Microsoft Windows (KB942763

)
)
)
Update for Microsoft Windows (KB941649)
)
)
)

L~ L~~~ |~ [~

Update for Microsoft Windows (KB939159

Figure 26: The Windows Vista SP1 updates we applied to each test system prior to running the Windows Vista SP1 tests.

Figure 27 lists all the updates we applied to Windows Server 2003 from the Windows Update site on 12/26/2007

Windows Critical and Recommended Updates for Windows Server 2003

Security Update for Internet Explorer 7 for Windows Server 2003 (KB938127)

Security Update for Windows Server 2003 (KB941569)

Security Update for Windows Server 2003 (KB944653)

Cumulative Security Update for Internet Explorer 6 for Windows Server 2003 (KB942615)

Security Update for Windows Server 2003 (KB941568)

Update for Windows Server 2003 (KB942840)

Update for Windows Server 2003 (KB942763)

Windows Malicious Software Removal Tool—December 2007 (KB890830)

Security Update for Windows Server 2003 (KB943460)

Windows Internet Explorer 7 for Windows Server 2003

Update for Windows Server 2003 (KB936357)

Security Update for Outlook Express for Windows Server 2003 (KB941202)

Security Update for Windows Server 2003 (KB933729)

Security Update for Microsoft .NET Framework, Version 1.1 Service Pack 1 (KB933854)

Security Update for Windows Server 2003 (KB936021)

Security Update for Windows Server 2003 (KB938127)

Security Update for Windows Server 2003 (KB936782)

(

Security Update for Windows Server 2003 (KB921503)
(
(

Security Update for Windows Server 2003 (KB926122)

Security Update for Windows Media Player 6.4 (KB925398)

Security Update for Windows Server 2003 (KB935839)

Security Update for Windows Server 2003 (KB935840)

Cumulative Security Update for Outlook Express for Windows Server 2003 (KB929123)

Security Update for Windows Server 2003 (KB924667)

Update for Windows Server 2003 (KB927891)

Windows Malicious Software Removal Tool—May 2007 (KB890830)

Security Update for Windows Server 2003 (KB931784)

Security Update for Windows Server 2003 (KB930178)

Security Update for Windows Server 2003 (KB925902)

Microsoft Corporation—Other Hardware—Microsoft UAA Bus Driver for High Definition Audio

Windows Server 2003 Service Pack 2 (32-bit x86)

Figure 27: The Windows Server 2003 updates that we installed on each Windows Server 2003 test server.
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Appendix C—Detailed test results

Figure 28 details the performance results for each of the test operations on each client system when running in
the Windows Server 2003 test bed. Figure 29 provides the same data for the Windows Server 2008 test bed.
Each result is how long the operation took to complete on the test operating system. Each result is the average of
five runs of the same operation in the same system state on each system.

System A System B System C System D
Vista Vista Vista Vista Vista Vista Vista Vista
SP1 SP1 SP1 SP1
Copy video LAN to local 107.04 | 12435 | 109.49 | 13293 | 105.16 | 120.32 | 108.95 142.35
Copy white paper LAN to local 5.72 6.47 5.93 7.44 5.62 6.46 6.08 6.65
Copy Q3 LAN to local 51.81 61.97 52.71 67.45 51.73 60.80 52.77 68.72
Copy brochure LAN to local 6.79 7.74 7.10 9.01 6.76 7.79 7.26 8.45
Copy images LAN to local 6.21 7.15 6.84 8.67 6.26 7.22 7.25 7.81
Copy white paper local to WAN 77.18 85.16 79.43 85.82 77.54 86.13 78.11 86.01
Copy Q3 local to WAN 920.42 | 957.53 | 935.81 959.05 | 934.36 | 958.07 | 935.79 | 959.10
Copy brochure local to WAN 104.74 | 11659 | 106.90 | 116.99 [ 105.67 | 116.86 [ 105.99 117.15
Copy AV Pix local to WAN 98.89 | 11448 | 100.09 | 115.24 99.01 114.51 99.59 115.37
Copy zip local to WAN 34.30 36.94 35.21 36.88 34.52 37.46 34.71 38.08
Copy white paper WAN to local 46.89 48.17 47.20 48.34 46.91 48.35 47.26 48.40
Copy Q3 WAN to local 48342 | 22216 | 486.82 | 22713 | 483.85| 221.08 | 487.14 | 229.19
Copy brochure WAN to local 63.73 71.44 64.13 72.09 63.78 71.91 64.27 72.07
Copy WB Pix WAN to local 64.37 84.57 64.73 85.17 64.45 84.80 64.81 85.05
Copy zip WAN to local 17.99 10.75 18.15 10.87 18.00 10.73 18.23 10.97
Copy video local to local 59.17 54.72 93.71 69.78 71.01 46.28 | 109.94 101.49
Copy Q3 local to local 28.05 28.80 50.47 38.26 32.61 25.78 52.04 47.49
Copy brochure local to local 5.15 5.25 5.88 6.80 5.17 5.12 7.09 7.61
Copy AV Pix local to local 4.93 5.1 5.14 6.21 4.59 4.97 6.82 7.03
Copy video local to LAN 101.53 [ 101.20 | 103.22 | 101.26 | 137.31 138.88 [ 104.43 101.48
Copy white paper local to LAN 5.88 6.19 6.18 6.45 7.06 7.26 6.22 6.62
Copy Q3 local to LAN 51.29 52.18 52.00 52.83 68.53 68.62 53.67 53.14
Copy brochure local to LAN 717 7.52 7.56 7.76 8.66 8.91 7.54 8.01
Copy AV Pix local to LAN 6.67 7.04 6.95 7.37 7.88 8.17 7.09 7.67
Copy zip local to LAN 3.99 4.63 4.29 4.59 4.59 5.44 4.49 5.56

Figure 28: Performance results for each of the test operations on each system under Vista and Vista SP1 on test systems
communicating with a server running Windows Server 2003.

System A System B System C System D

Vista Vista Vista Vista Vista Vista Vista Vista

SP1 SP1 SP1 SP1
Copy video LAN to local 100.90 | 125.06 | 101.25 | 132.96 | 100.79 | 121.23 | 101.22 148.37
Copy white paper LAN to local 5.65 6.45 5.67 7.30 5.60 6.42 5.71 6.59
Copy Q3 LAN to local 50.58 61.84 50.63 67.75 50.55 60.54 50.75 69.38
Copy brochure LAN to local 6.78 7.63 6.80 8.91 6.74 7.82 7.04 8.67
Copy images LAN to local 6.10 7.03 6.28 8.74 6.19 7.16 6.44 7.87
Copy white paper local to WAN 18.81 36.88 19.36 46.37 19.73 46.28 19.30 40.35
Copy Q3 local to WAN 103.27 | 17240 | 11825 | 179.84 | 117.79 | 18144 | 117.70 177.64
Copy brochure local to WAN 22.76 47.15 23.17 47.84 23.86 48.04 22.94 47.73
Copy AV Pix local to WAN 27.73 57.71 28.15 57.99 28.20 58.05 28.15 57.73
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System A System B System C System D

Vista Vista Vista Vista Vista Vista Vista Vista

SP1 SP1 SP1 SP1
Copy zip local to WAN 5.44 12.51 5.52 12.77 6.06 12.67 5.37 12.84
Copy white paper WAN to local 27.73 50.06 27.43 49.86 29.12 49.85 28.85 49.76
Copy Q3 WAN to local 119.29 [ 225.11 116.54 | 229.72 | 115.87 | 228.57 | 118.37 | 229.93
Copy brochure WAN to local 28.76 71.72 28.07 74.41 28.78 75.67 29.80 72.26
Copy WB Pix WAN to local 33.11 84.60 31.04 86.97 31.79 87.94 31.69 85.01
Copy zip WAN to local 8.52 14.77 8.48 14.67 7.22 12.63 13.98 12.56
Copy video local to local 58.07 55.14 91.50 70.98 68.58 46.33 | 106.42 100.96
Copy Q3 local to local 26.98 27.80 48.68 38.75 31.45 25.47 50.47 50.54
Copy brochure local to local 5.03 5.18 5.51 7.19 4.58 5.18 7.15 7.68
Copy AV Pix local to local 5.12 5.03 5.31 6.46 4.46 4.84 6.50 6.87
Copy video local to LAN 100.99 [ 101.16 | 100.97 | 101.21 137.52 | 136.56 | 101.32 101.59
Copy white paper local to LAN 6.43 6.10 7.05 6.52 7.62 7.29 7.10 6.59
Copy Q3 local to LAN 52.69 52.04 53.90 52.81 70.41 69.10 54.35 53.15
Copy brochure local to LAN 7.32 7.43 7.98 7.93 9.14 8.94 8.30 7.98
Copy AV Pix local to LAN 7.33 7.05 7.77 7.57 8.41 8.11 8.09 7.69
Copy zip local to LAN 3.95 4.77 4.27 5.07 4.70 5.43 4.29 5.74

Figure 29: Performance results for each of the test operations on each system under Vista and Vista SP1 on test systems
communicating with a server running Windows Server 2008.
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Appendix D — Configuration and test results for the HP a1320y

Figure 30 provides detailed configuration information about the Hewlett-Packard a1320y desktop system. We
omitted that system from the body of this report because it produced unacceptably high variability in its test

results.

System Hewlett-Packard a1320y
General

Processor and OS kernel: (physical, core,

logical)/(UP, MP) 1P1C2L/MP
Number of physical processors 1

Single/dual-core processors Single

Processor HT status Enabled

System Power Management Policy (Vista) High performance
Notebook processor power saving option NA

Notebook dimensions (length x width x NA

height)

Notebook weight NA

CPU

System type Desktop

Vendor Intel

Name Pentium 516
Stepping 9

Socket type LGA775

Core frequency (GHz) 2.93

Front-side bus frequency (MHz) 533

L1 cache 16 KB + 12 Kuops

L2 cache 1 MB

Platform

Vendor and model number HP a1320y
Motherboard model number Asterope
Motherboard chipset ATl RS400
Motherboard revision number 01

Motherboard serial number MXG61801W2NA620
BIOS name and version American Megatrends v3.07
BIOS settings Default

Memory module(s)

Vendor and model number Hyundai Electronics HYMP564U64P8-C4
Type PC2-4200

Speed (MHz) 533

Speed running in the system (MHz) 266

Timing/Latency (tCL-tRCD-tRP-tRASmin) 4-4-4-12

Size 512 MB

Number of memory module(s) 1x512 MB

Chip organization Single-sided

Channel Single
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System

Hewlett-Packard a1320y

Hard disk

Vendor and model number

Western Digital WD400BD-60LRAO0

Number of disks in system

1

Size 40GB

Buffer size 2 MB

RPM 7200

Type SATA 300 Mb/s

Controller ATI SB400

Driver Microsoft 6.0.6000.16386
Graphics

Vendor and model number ATI Radeon Xpress 200
Chipset ATl Radeon Xpress 200 Series
BIOS version BK-ATI VER008.0461.003.000
Type Integrated

Memory size 256MB

Resolution 1280 x 1024

Driver ATI1 8.383.0.0

Audio

Vendor and model number

Realtek High Definition Audio

Driver

Realtek Semiconductor Corp. 6.0.1.5372

Ethernet

Vendor and model number Realtek RTL8139

Type Integrated

Driver Microsoft 5.640.630.2006
Modem

Vendor and model number

CXT Data Fax SoftModem with SmartCP

Driver

CXT 7.61.0.0

Optical drive(s)

Vendor and model number

Asus DVD-E616A

Type DVD-ROM
Single / Dual Layer NA

USB ports

Number of ports 6

Type of ports (USB1.1, USB2.0) USB2.0
IEEE 1394 ports

Number of ports | 2

Monitor

CRT/LCD ViewSonic Optiquest Q7
Screen size 177
Refresh rate 60 Hz
Wireless

Vendor and model number NA

Driver NA
Battery

Type NA

Size (length x width x height) NA

Rated capacity NA
Weight NA

Figure 30: Test system configuration.
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Figure 31 details the performance results for each of the test operations on a Hewlett-Packard a1320y desktop
PC when running in the Windows Server 2003 test bed. Figure 32 provides the same data for the Windows
Server 2008 test bed. Each result is how long the operation took to complete on the test operating system. Each
result is the average of five runs of the same operation in the same system state on each system.

Hewlett-Packard
a1320y
Vista Vista
SP1

Copy video LAN to local 108.97 | 121.78
Copy white paper LAN to local 6.08 7.28
Copy Q3 LAN to local 52.66 61.89
Copy brochure LAN to local 7.16 8.88
Copy images LAN to local 6.75 8.90
Copy white paper local to WAN 77.84 85.46
Copy Q3 local to WAN 934.38 | 961.87
Copy brochure local to WAN 106.09 | 117.22
Copy AV Pix local to WAN 99.70 | 114.91
Copy zip local to WAN 34.80 37.04
Copy white paper WAN to local 47.32 48.82
Copy Q3 WAN to local 485.92 | 223.31
Copy brochure WAN to local 64.27 72.52
Copy WB Pix WAN to local 64.75 85.47
Copy zip WAN to local 18.17 10.91
Copy video local to local 70.18 | 47.33
Copy Q3 local to local 31.64 27.15
Copy brochure local to local 5.24 5.68
Copy AV Pix local to local 5.14 5.16
Copy video local to LAN 109.46 | 138.46
Copy white paper local to LAN 6.03 7.50
Copy Q3 local to LAN 51.80 70.17
Copy brochure local to LAN 7.44 9.33
Copy AV Pix local to LAN 7.04 8.58
Copy zip local to LAN 4.11 4.92

Figure 31: Performance results for each of the test operations on the test system under Vista and Vista SP1 when
running in the Windows Server 2003 test bed.
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Hewlett-Packard
a1320y
Vista Vista
SP1

Copy video LAN to local 101.43 | 123.31
Copy white paper LAN to local 5.90 7.07
Copy Q3 LAN to local 50.47 63.20
Copy brochure LAN to local 6.95 8.87
Copy images LAN to local 6.65 8.76
Copy white paper local to WAN 18.81 43.58
Copy Q3 local to WAN 103.99 | 180.14
Copy brochure local to WAN 22.78 | 48.20
Copy AV Pix local to WAN 27.83 57.76
Copy zip local to WAN 5.58 12.53
Copy white paper WAN to local 25.54 51.09
Copy Q3 WAN to local 113.65 | 223.40
Copy brochure WAN to local 28.56 73.76
Copy WB Pix WAN to local 32.57 73.13
Copy zip WAN to local 8.75 11.08
Copy video local to local 66.49 47.33
Copy Q3 local to local 31.49 27.18
Copy brochure local to local 5.07 5.48
Copy AV Pix local to local 4.83 5.03
Copy video local to LAN 101.79 | 138.60
Copy white paper local to LAN 6.64 7.50
Copy Q3 local to LAN 52.94 59.16
Copy brochure local to LAN 7.81 13.50
Copy AV Pix local to LAN 7.31 13.04
Copy zip local to LAN 4.26 5.54
Figure 32: Performance results for each of the test operations on the test system under Vista and Vista SP1 when
running in the Windows Server 2008 test bed.
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About Principled Technologies

We provide industry-leading technology assessment services. We bring to every assignment extensive
experience with and expertise in all aspects of technology testing and analysis, from research into new
technologies, to the development of new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We

provide our clients with the materials they need, from market-focused data to use in their own collateral to custom
sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results
of our trusted independent analysis.

We provide customized services that focus on our clients’ individual needs. Whether the technology involves
hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help you assess how
it will fare against its competition, its performance, whether it's ready to go to market, and its quality and reliability.

Our founders, Mark Van Name and Bill Catchings, have worked together in technology assessment for over 20
years. As journalists they published over a thousand articles on a wide array of technology subjects. They created
and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis
Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company
by Lionbridge Technologies were the head and CTO, respectively, of VeriTest.
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Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS
TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR
IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING
ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE
RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS
EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE
ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE
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